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1 Introduction 

1.1 Overview 

Introduced in 1994, GSolver is a full vector implementation of a class of 

algorithms known as Rigorous Coupled Wave (RCW) Analysis. These 

algorithms give a numerical solution of Maxwell’s equations for a periodic 

grating structure that lies at the boundary between two homogeneous linear 

isotropic infinite half spaces: the substrate, and the superstrate. The solution 

is rigorous in the sense that the full set of vector Maxwell’s equations are 

solved with only the following two simplifying assumptions: 1) a 

piecewise-linear approximation to the grating construction, and 2) a 

truncation parameter for the Fourier series representation of the permittivity 

(and impermitivity) within each grating layer. GSolver is set up to work 

with linear isotropic homogeneous materials. 

Within GSolver, a grating is specified by a series of thin layers. Each layer 

consists of (box shaped) regions of constant indices of refraction. By 

allowing the scale of this approximation to decrease, a spatially-continuous 

grating structure can be approximated to any desired accuracy. 

The GSolver executable is static linked, for 64bit build. This means that it 

is a stand-alone application and does not rely any Microsoft© DLLs. 

However, the basic graphics (charting) engine requires the ProEssentials9© 

PEGRP6SG.dll as well as the GDI library (which is a native component for 

most Microsoft OS). The additional graphics DLL is copied to the local 

GSolver directory to minimize possible conflicts with any other 

applications.  

GSolver uses the system registry to store the user tool bar and menu 

selections, basic form layouts, and working file names. The materials 

catalog is called GSolver.ini and is a text file (it may be edited directly with 

any text editor, or using the GSolver Editor). This file should also be found 

in the local GSolver install directory. 

NOTE: It is highly recommended that after initial install and registration 

that the Toolbar be customized to include the several grating profile drawing 

tools, and to remove tools that are seldom/never used (such as Text, ports, 
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lines). Customization of the toolbars is found under main 

menu→Tools→Customize. 

 

1.1.1 GSolver Installation 
 

The installation dialog is created by a standard MicroSoft® Setup routine. 

After specifying a destination location (it is recommended that GSolver be 

copied to its own file location and not in any system OS or otherwise 

protected director, such as Program Files, or Windows). The following 

files are copied on install: 

 GSolverV60.exe the main program 

 GSolver.ini  the materials file (text) 

 PEGRP6SG.DLL the graphics/plotting engine 

 UserManualGsolver60.pdf this document 

 Legal Notice.pdf copy directing attention to Single User 

License 

 LicenseStatement.pdf Single User License  

 

Additionally, GSolver Shortcuts created for the desktop. GSolver uses the 

registry to store toolbar customizations, so it is worthwhile to customize 

(Menu→Tools→Customize) by dragging the various profile design icons 

to a toolbar, activating the Rotate (and/or other design toolbars) and 

removing seldom used icons (such as the Text, Ports, and Line functions).  

1.1.2 New V6.1 Features 

GSolver Version 6.1 is compiled as a native 64bit application. For older OS 

that do not fully support 64bit (x64) applications, GSolver V5.2 remains 

available for download, and will accept the same install key code as V6.1.  

V6.1 upgrades to the Solver routines (TE, TM, 3D solvers) include severa; 

improvements to memory management, as well as multi-threading (for 

multi-processor environments). Additionally the Genetic Algorithm (see 

chap. 7) has been enhanced, and several potential ‘bugs’ (yielding 

nonphysical results) have been trapped. Modifications to the Graphic 

Grating Editor have also been made to make design dimensions more 
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transparent, with tighter integration with the layer/by/layer GS4 Editor 

(tab).  

 

The Runge-Kutta, and Burlisch-Stoer, together with the extended precision 

(128/256 bit floating point) solver methods have been removed as extensive 

experience indicates that they offer little advantage. If for any reason these 

methods are needed, V5.2 remains available for download. 

 

The ‘Angles Tab’ has been replaced with a simple dialog that provides 

solution to the grating equation for finding any diffracted order angles. 

 

A ‘snap shot’ picture of the current grating geometry tool has been added to 

help visualize the grating problem set-up.  

 

1.1.3 V5.2 Features 

Version 5.2 represents a major rework of previous versions of GSolver. 

(V4.20c is the prior version.) Many features have been added, many others 

expanded. Following is a list of the principal differences between V5.2 and 

previous versions: 

- Graphical Grating Editor 

- Automatic piecewise approximation construction 

- Greatly expanded genetic algorithm for automatic design 

- General algebraic constraints and equation editor 

- Improved graphing 

- Object linking and embedding (for interfacing to other programs 

with drag and drop capability) 

- Modified interface with independent floating GSolver windows 

- The materials file (Gsolver.ini) is now written to the root 

directory (location of the GsolverV52.exe file) 

- More consistent use of units. All forms now expect input in the 

user Units selection (made on the Parameters tab). 

- The genetic algorithm merit function has been expanded to 

allow for summing of result over a set of angles or 
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wavelengths. This allows for optimization over certain 

parameter ranges. 

 

The results of a Grating Listing run or a GA run can now be copied to the 

internal piecewise grating structure allowing for additional analysis by 

accessible from the RUN tab. 

 

 

1.2 GSolver Grating Definition  
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All calculations are performed on the ‘discrete approximation’ of the 

grating structure. This is best viewed/examined from the Listing/RUN view 

tab or in the GS4 Editor (scrolling through the grating layers). Note that any 

changes you make on the Listing/RUN view grid may be copied to the 

‘Discrete approximation’ data structure with the ‘Copy/Update’ button on 

the Listing/RUN grid. The ‘Populate’ button copies the current 

‘Discrete/approximation’ data structure to the Listing/RUN grid.  

 

All horizontal dimensions of the ‘Discrete approximation’ are relative to 

the Period which is set on the Parameters tab. Thus, all layer Widths must 

total to 1.0 on the Listing/RUN grid or the GA Grid. The width of the 

drawing Canvas (Graphical Editor) is always set = one Period.  

 

All vertical dimensions are absolute (based on the Units set on the 

Parameters tab). The Canvas dimensions may be adjusted through the 

Measurements dialog (click the Measurements button in the Graphical 

Editor, and see chap 4 for details).  

 

Remembering the above two principles will alleviate sources of confusion 

when designing gratings. In general, it is good practice to ‘populate’ the 

Listing/RUN grid and do a quick check that the physical dimensions are as 

expected.  

 

The RUN command (on the Listing/RUN, GA, and Run tabs) operate on 

the ‘Discrete approximation’ data structure. 

 

1.3 Example Runs (Quick Start) 
 

The GSolver V6.1 install directory should include GsolverV60.exe, 

Gsolver.ini (the materials catalog), this Users Guide, and PEGRP6SG.dll 

(for graphics). If an INI file is not found, GSolver will create one with a 

(minimal) default for each material class. Prior version INI files may be 

used. See Chapter 14 for a description of the INI (materials) file. It is 

recommended that GSolver not be installed in any System restricted 

directories (e.g. Programs Files, Windows, etc.) which may be problematic 
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for certain read/write operations (such as for the INI) based on local 

machine security settings.  

 

1.3.1 Binary Grating Example 

This section gives a step-by-step example for creating a single binary layer 

grating (one layer with one index transition). 

1. Open GsolverV6.1 

2. The Parameters form is the global settings home. The substrate and 

superstrate materials may be selected here. Select a substrate and 

superstrate material by clicking on the appropriate select buttons. 

3. Enter the grating period (or lines/mm), wavelength, and other 

parameters. (A discussion of the angles is given in the Parameters 

Tab chapter.) 

4. Now click on the Graphical Editor tab. Shown on this tab is the 

graphical working area called the Canvas (see chapter 4). The 

substrate is located at 0 and below, referenced to the ruler on the left, 

and is not shown on the canvas. 

5. This example employs the square (rectangle) shape button to draw 

a rectangular structure. If it is not already present on the toolbar, use 

the menu item Tools→Customize to add the drawing tools to the 

toolbar. (See the section on toolbars if needed.) 

 

6. Click on the square tool button. Place the mouse cursor anywhere 

on the active area of the canvas, and, while holding down the left 

mouse button, drag the mouse to create a rectangle on the canvas. 

7. Move the mouse cursor into the interior of the rectangle and right 

click. This brings up an item property menu. Select Properties. 

8. Select the Material tab and select a material for the rectangular 

region just created. In principle, any shape may be made, and 

assigned a property. For overlapping shapes, the region on top is 

used when making the grating definition. 

9. Drag the rectangle to the bottom of the canvas so it rests on the 

substrate region. 

Drawing 

Tools 
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10. The width of the canvas is normalized to 1 grating period. The 

default view region can be sized to any reasonable size (from the 

Measurements dialog), however the width of the Canvas is 1 period 

no matter how the canvas is sized for display purposes. This is 

explained more in the Editor chapter. The default height of the 

Canvas in also 1 period (in absolute units) 

11. Recalling that periodic boundary conditions are assumed, the single 

rectangle drawn on the canvas represents a binary grating looking 

edge on. Once the grating is defined with the graphical editor, an 

internal piecewise-constant approximation needs to be created. This 

gives the representation used in the Run analysis. 

12. Click on the Approximation radio button near the upper right corner 

of the canvas area to create the piecewise constant approximation. 

Each time this button is clicked, and only then, the internal 

representation of the piecewise constant construct is recalculated. 

To see a 3D rendering of the grating geometry, click on the menu 

item Tools->3D Grating View. 

13. The spatial resolution of the Piecewise Constant construction is 

determined by the canvas grid (see Editor Tab for greater detail). It 

can be made finer  by editing the Canvas Properties from the 

Measures button. Note that the actual layer and inter-layer geometric 

dimensions of any piecewise constant feature are accessible, and 

modifiable on the Listing/RUN tab or easily in the GS4 Editor. 

14. Click the Run tab. Using the check boxes, select a parameter vary, 

enter limits and then click the RUN button. The calculated results 

are shown on the Results Tab. Note that the ORDERS entry 

specifies the truncation order of the Fourier Series representation of 

the layer permittivity function. Layers with many index transitions 

need more Fourier terms. This should be set large enough to assure 

convergence, and adequate representation of the permittivity. Click 

RUN for an efficiency calculation. Results are shown on the Results 

tab (select various columns for Graphing). 

15. Alternatively, click on the Listing/RUN. 

16. On the Listing/RUN tab click the Populate button to load the grating 

structure from the current internal piecewise constant construct. If 

the ‘Approximation’ button on the Editor form has not been clicked, 
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this construct is empty, and so nothing will change. The piecewise 

constant listing is discussed in the Listing/RUN chapter. 

17. For this example, the Listing/RUN will be used for a couple of 

simple calculations. To create a run with the width of a ‘block’ (Duty 

Factor) changing. Enter the following formula into grid B14 

=D5 

 And 

  =1-D5 

 In cell B17. Change F5 to 1. And E5 to 0.01. 

All cell formulas begin with an equals sign (=) and are calculated 

immediately. [To toggle between formula view, and value view use 

the menu Formulas→Formula View.] The formula engine included 

in GSolver is very extensive and powerful. It includes all common 

functions, and logicals, with logical conditional constructs. The 

formula engine is discussed in the Grid Formula chapter. Any cell 

can be used in any formula as long as nested iterations and a few 

restricted cells are avoided.  

18. This Listing/RUN grid comes equipped with a single free parameter 

in cell D5. Enter the parameter increment and stop values as 

mentioned in E5 and F5; set to 0.01 and 1 respectively. Set D5 to 0. 

This will cause the value of width (formula entered in B14, B17) to 

change from 0 to 1 in steps of 0.01 during the Run. 

19. Now click on the RUN button in cell D9. The first thing that happens 

is that GSolver cycles through the parameter range. For complicated 

formulas the increment and decrement buttons may be used to single 

step the grid computation to verify correct behavior. 

20. After the first run through, the parameter loop is reset, and then on 

each parameter increment the current grating structure, as defined 

on the grid, is sent to the solver routines. The solution is written to 

the Results grid (Results tab). 

21. At the completion of the loop, the Results tab is displayed. Select 

any column(s) to graph by clicking on their headings. Multiple 

columns are selected using the shift and ctrl keys along with the 

mouse in the usual manner. The many options available for 

graphical display are discussed in the Graphing Options chapter. 
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22. Return to the Listing/RUN tab. Reset the parameter D5 to 0 and 

change cell B2 to 10 for a fixed 10-degree incidence angle. 

23. Enter the following formula in cell B6 (wavelength): 

=if(D5>.5,D5,.5) 

This is a form of a conditional entry. The wavelength remains 

constant (0.5 microns) if D5<=0.5. Otherwise, it changes linearly 

with D5 as given in the formula. 

24. In cell B7 enter the following formula 

=1.+D5/100. 

Set D5 = 0., and F5 = 1.0. This formula changes the grating period 

from 1 to 2 linearly as D5 changes from 0 to 1. Set B14 = 0.5, and 

B17 = 0.5. 

25. Click the Run button and examine the results. 

Note that the thickness of any layer can be entered as a constant or through 

a formula on the grid listing. With this capability all film thicknesses 

(layers) can be accurately set; the finite grid resolution of the canvas does 

not limit layer thicknesses. Alternatively, using the GS4 Editor, you may 

scroll through each layer and adjust any feature using the mouse to drag 

boundary transitions, or the text entry boxes. The GS4 Editor updates the 

Discrete Approximation immediately (no ‘approximate’ function).  

Note: It is fairly straight forward using the floor(), int(), round() functions 

to split the D5 free parameter into several. For example, set D5 to run from 

0 to 100 in steps of 0.1. Then set some free cell =frac(D5), and another cell 

to =int(d5/10). The first cell changes rapidly, while the second cell counts 

slowly.  

1.3.2 Blaze Grating Example 

This example uses the Blaze grating tool button that shows a Blaze profile 

in black. (Note that standard textbook grating examples that introduce 

blazed gratings are based on scalar diffraction theory ideas. GSolver is full 

vector calculation.) This is a general tool that includes common grating 

design tasks.  

 

 
Blaze Tool 

Button 
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1. Open a new Grating form (for example File->New). Set global 

Parameters as you like. From within the Graphical Editor tab, click 

on the Blaze tool button. This brings up the Custom Profile 

Construction dialog which includes Blaze, Triangle, Sinusoidal, 

Piecewise linear, and Piecewise spline. 

2. In the Blaze grid profile, select the desired blaze angle (change the 

default 35 in cell C3, or leave it as 35). Click OK. 

3. A blazed profile is created. A blaze grating profile is a right triangle. 

The triangle should have the correct dimensions (as can be checked 

on the Listing/RUN after ‘approximation’, but note that the vertical 

scale is unnormalized, and shows absolute dimensions.) Select a 

material property for the triangle by right clicking it. 

4. At this point it is easy to create a conformal layer for this profile. 

Select the triangle shape just created with a mouse click, then hold 

down the control key, and click and drag the triangle. A copy of the 

triangle is created. Change the properties of the new triangle. Then 

send it behind the original triangle by right clicking the new triangle 

and using Order→Send to Back. Move the second triangle so that a 
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thin conformal layer is created around the original triangle. The 

small gaps left in the lower right and left sides can be filled in with 

rectangles of the appropriate material settings. 

5. Click the Approximation button to create the piecewise constant 

approximation used by GSolver.  

6. Perform a grating calculation using the RUN or Listing/RUN tab. 

 

1.3.3 Another Blaze Procedure 
 

1. Start a New grating, and set the superstrate, substrate, Period, 

wavelength and so forth on the Parameters tab. 

2. Click over to the GS4 Editor and click on the N-ties option. This 

brings up a GS4 dialog (more on this in the GS4 section below). 

3. Enter the desired blaze angle in the Balze angle calculator, press 

the ‘enter’ key to display the result. Note the ‘pct’ value. This is 

the position of the apex of the ‘triangle’ profile relative to the 

current Period. 

4. Click on the handle in the graphic and drag the handle so the x: 

position is either the pct value or 1-pct value (depending on 

left/right orientation).  

5. Enter the h: value in the Total thickness box (which translates to 

the maximum y-dimension for the profile). 

6. Decide on the number of levels you want for the discrete 

approximation. 

7. Set the base and top index values and click OK. 

8. The resulting stack of layers may be scrolled through using the 

Curent Layer scroll button. The layer is shown, and modifications 

can be made by clicking and dragging a boundary, or by double 

clicking to bring up the Material Properties dialog to modify the 

region material/index of refraction. 

 

1.3.4 Cautionary Comments 
 

The computation of the Diffraction Efficiencies is exact in the sense that the 

truncated Fourier representation of each layer permittivity is sufficiently 

accurate (the higher order spatial harmonics can be ignored). One way to 
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determine ‘convergence’ is to fix all parameters and do a RUN as a function 

of Orders retained. The results should show convergence towards the 

limiting value.  

 

One should also be aware that there are contributions to the diffraction 

efficiency due to the ‘corners’ and layering piecewise approximation. For a 

coarse approximation (few layers approximating say a blaze profile) one is 

actually computing a stack of laminar block gratings. Each layer has a field 

solution, and the fields interact with each other across all the boundaries. 

To limit ‘corner’ effects one should investigate how the diffraction 

efficiency varies as a function of the number of layers used in the 

approximation. A general rule of thumb is that ‘corner’ features should be 

< lambda/10 in the material (high index materials require more layers). 

Alternatively, one may be able to find a grating structure with just a few 

layers, or several blocks in a layer that performs as good or better than a 

classical profile using the Genetic Algorithm to search through a design 

space.  

 

Finally, there are computational regimes that 64bit floating point, and 

Coupled Wave solution approach is not ideal. Other algorithmic approaches 

such as Integral Boundary methods, Coordinate-transformation, FDFD (or 

FDTD), as well as a variety of alternative orthogonal function basis sets, 

and analytic basis approaches may better fit a particular type of grating 

profile. There is no ‘best’ method. If the results of the eigensystem 

calculation for any layer leads to numeric over/underflow the Results are 

flagged with a NAN. At times small perturbations of wavelength or Period 

(or material) may be sufficient to recover from NAN. However, a large 

number of NAN results is clear indication that the modeled grating regime 

may benefit from some alternative calculational approach. 

 

GSolver is targeted for devices that are built using photolithography 

methods, resulting in gratings with discrete ‘blocks’ as in the piecewise 

constant approximation. In this case the approximation is closer to the 

physical representation.  
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2 General Principles 

2.1 Overview 

Several copies of GSolver may be open at a time. Each top-level GSolver 

window, as depicted in the figure above, is designed to operate on a single 

local grating structure. 

The objects in blue are shared components. The objects on the left are 

unique to each top level GSolver window. Therefore, if multiple GSolver 

windows are open, each with some grating structure entered, then all 

parameter settings are unique to that window’s particular grating. 

When GSolver is started, the first order of operation is to look for the INI 

file in the local directory where GSolver was launched. If GSolver does not 

find one, it creates a new one with default materials of each type. 

When GSolver shuts down, its final operation is to rewrite the INI file with 

the current material structure. Thus, if there are multiple GSolver windows 

open from the same directory, the last one closed will overwrite the INI file 

of any previous closures. This should be kept in mind when using the 

GSolver material editor to add or otherwise change the material catalog. 

User Interface

(GUI)

Data Structures:

Global Parameters

Material catalog

Graphical object description

Grid data

Piecewise constant 

grating structure

Grid Formula Engine

Maxwell equn. solver

Canvas 

drawing 

editor

Graphing utility
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2.2 Drag and Drop 

GSolver V6.1 is built as an OLE (Object Linking and Embedding) object. 

This permits the various graphical fields to be dragged between different 

GSolver windows, as well as any other OLE enabled application (such as 

the Microsoft© Office applications).  

2.3 Importing grating definition by text file 

A grating may be defined in text format external to GSolver and imported 

using the  

File → Import Text  

menu item when the Graphical Editor tab is active. 

 

2.3.1 Grating Text File Format 
 

Following is an example grating TEXT definition file format for a two-layer 

grating structure. The first layer has two block regions, and the second layer 

has four block regions.  

 

[LAYER] 

 0.213 

 0.2 DRUDE Lead true 

 0.8 CONSTANT Ones false 

[LAYER] 

 0.132 

 0.12 SCHOTT BSC4h true 

 0.22 HERZBERGER KCL true 

 0.26 TABLE SIPOLY10 true 

 0.4  CONSTANT Ones false 

[END] 

 

Layers are numbered starting with the substrate and moving up. The 

LAYER description starts with the first layer on top of the substrate 
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(which is defined within GSolver on the Parameters tab) and is identified 

with the 

 

[LAYER] 

 

keyword. The first line following the [LAYER] keyword is the 

THICKNESS of the layer in MICRONS (be sure to leave the default 

GSolver units on the parameters tab as Microns when loading a text grating 

file). 

 

Following the thickness line is a line for each block of material within a 

single Period. There must be at least one block definition (a uniform layer 

will have width 1.0).  

 

A block definition consists of four entries on the same line: a relative width 

(based on grating period), a material catalog type which must be one of 

 

CONSTANT, TABLE, SCHOTT, SELLMEIER, DRUDE, 

HERZBERGER, or POLYNOMIAL 

 

which are the seven index models used in GSolver; the catalog entry  

NAME of the material, which must be listed in your GSolver.ini (and loaded 

into GSolver). The final entry is a flag (true/false) which tells GSolver to 

update the index value if the wavelength changes or not.  

 

If a block definition line does not have four entries an error will occur.   

 

The sum of the block widths must total 1.0 otherwise an error condition is 

set and the file read aborts.  

 

A typical file import would proceed as follows: Open a new GSolver 

instance, set the Parameters to some nominal values (using microns) then 

click on the Graphical Editor tab and then click (from the menu) 

File → Import Text  
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This action will initiate a file read dialog box. Navigate to the text file which 

contains your grating definition as explained above and open it. GSolver 

will read the file and update the Editor window. 

 

NOTE: DO NOT CLICK the APPROXIMATION button if you do not want 

GSolver to approximate the layer widths and thicknesses to the Canvas grid 

spacing. Rather go directly to either Run or Listing/Run and populate the 

grid.  

 

When the text file is read in, the grating is already defined as a piecewise 

constant structure. Therefore, the internal grating structure is updated 

automatically and there is no reason to ‘approximate’ it using the Editor 

tool.  

2.4 Importing V4.20c 

An import function is provided to convert GSolver V4.20c binary grating 

files (*.gs4) into the V6.1 format. In many cases the material index of 

refraction properties were assigned constant values in V4.20c. On import, 

the constant index of refraction properties are translated into a material type 

CONSTANT (see Gsolver.ini file format), and this property is added to  the 

current material list automatically if it is not found.  

To import a V4.20c GSolver object, open a new GSolver window and click 

on the Editor tab. Then click on the menu item File→Import GS4.20c. A 

file open dialog is created in which you should select the existing *.gs4 file. 

After selection and clicking the OK button, GSolver creates a dummy 4.0 

data structure and loads the *.gs4 binary object into it. It then reads through 

the data structure and creates a V6.1 data structure from it, using default 

values for any information that are not assigned  

2.5 Forms 

GSolver is a form-driven application. The various data fields that define a 

grating, and the intended calculations, are arranged by class on different 

forms. The forms are labeled Parameters, Graphical Editor, GS4 Editor, 
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Listing/RUN, GA (Genetic Algorithm), Run, Results, 3D Editor, and 3D 

Run. Each form is described in the following chapters. 

Forms are activated by clicking on tabs, and the data fields in each form 

provide interfaces to the internal data structure (of which there is one for 

each top-level GSolver window). 

2.6 Toolbars and Menus 

Several toolbars are provided for access to various GSolver functions. Most 

of the tools relate to the graphical grating design interface. The toolbars can 

be customized by adding and removing buttons, and grouping them as 

desired. These toolbar buttons are described below. 

The Tool Customization dialog is activated by clicking on the menu item 

Tools→Customize.  

Use the toolbar Customize dialog to turn on and off any toolbar, and use the 

Command page of the toolbar Customize dialog to add or remove buttons 

from any toolbar. Command buttons may be dragged from one toolbar to 

another. To remove a button from a toolbar simply drag it from the toolbar 

to the Command button palette. 

Toolbars are docking enabled. 

2.6.1 Menu bar 

 

The File menu item includes the commands for saving and loading saved 

gs5/6 (GSolver V6.1) grating files. It also hosts the printing commands. The 

print commands will be active for any form that supports printing. 

The Edit menu command list includes several actions that apply to the grid 

data structures in the Listing/RUN form, the GA form, and the Results form. 

The bottom section of the Edit menu contains a group of commands that 

apply to the graphical Editor form. Although most of these commands are 

assumed to be self-explanatory, notes for commands are presented below: 
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Edit→Components − This command activates the Components dialog. 

Each object/primitive on the Editor canvas is identified with a default name. 
This dialog helps navigate a grating construct with numerous objects. It also 

provides an alternative way to call up the properties dialog for any object 

primitive. 

Edit→Properties − The Properties dialog can be used to define the 

properties of the selected Editor drawing object. The essential property is 

the Material, which defines the index of refraction for the object. Other 

properties are included for convenience, and include the object name, edit 

flags (indicating whether a property can be altered) the thickness of the 

boundary line, and the color. By default, the object color is tied to the index 

of refraction. Note that the boundary line is generally not used in creating 

the piecewise constant approximation of the canvas objects. However, if the 

boundary line is made thick enough, and intersects a grid point, it may be 

included and assigned default superstrate properties by the piecewise 

constant algorithm.  

Edit→Default Properties − The Default Properties are used when a new 

graphical object is created. Note: the Material Property does not take a 

default value but is always set to the substrate material property. 

Edit→Canvas Properties − This dialog allows control of the relative 

canvas size (number of canvas units with respect to 1 Period). See the Editor 

form chapter for more details. 

Edit→Color Map − This Dialog controls the color look-up table for the 

real and imaginary parts of the index of refraction. See the Refractive Index 

Color Map Dialog for more details. 

Edit→Material − This command brings up the Materials editor dialog. See 

the Materials Editor dialog for more details. 

The Format and Grid menu items apply to the data grids on the various 

forms. Several command items apply only if the grid item has been selected. 

If a command does not apply it is grayed out (disabled). 

The Formulas menu item group applies to the Listing/RUN and GA grid 

formula engine, which is detailed in the Grid Formula Engine chapter. 
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2.6.2 Main 

 

The default Main command button bar contains the following commands: 

New − start a new GSolver window 

Load − load a saved (*.gs6) grating structure 

Save − a grating structure 

Cut, copy and paste, apply to graphical as well as to data items 

Print 

2.6.3 Drawing 

 

The default Drawing command button bar contains commands to generate 

various graphical primitives. Included on this command bar are additional 

buttons to instantiate the Materials Editor, and the Color Map dialogs. Other 

drawing commands − line, polyline, text fields, bitmaps, and ports − are 

included for convenient grating design annotation and markups, and are not 

otherwise used for actual grating structures.  

2.6.4 Rotate 

 

These commands are used to rotate graphical primitives. The default canvas 

properties include a snap to grid (allows only discrete moves based on grid 

spacing) and angle snap (discrete angles based on grid spacing). These snap 

properties may be toggled on or off. 
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2.6.5 Layout 

 

The Layout commands are used to size multiple selected drawing objects to  

each other. Use the shift key in concert with mouse button to select multiple 

objects. 

2.6.6 Align  

 

The Align commands are used to align multiple selected drawing objects 

with each other. 

2.6.7 Nudge 

 

The Nudge commands move the selected object a small distance in the 

indicated direction, but do not allow moving past canvas boundaries. 

2.6.8 Structure 

 

The Structure command buttons can be used to alter the z-order (which 

object is on top) of overlapping objects. When creating the piecewise 

constant approximation of the grating, the top-most object is used at each 

grid sample point to define which material property to use. 
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2.6.9 Zoom 

 

The zoom and pan commands affect only the canvas view; they have no 

effect on the internal object dimensions which are sized to units of the 

grating period. 

2.6.10  Canvas 

 

The Canvas command buttons include the undo and redo commands (also 

accessible with control-z and control-y) as well as the grid and canvas 

property dialogs.  

2.7 Index of Refraction 

Each enclosed region/object on the Canvas should be assigned a material 

property from which an index of refraction is calculated. The default is for 

each material to use the substrate property as assigned on the Parameters 

form. 

GSolver comes with several predefined material properties in each model 

class. This list is not exhaustive and it is expected that materials will be 

added as needed by the user. This can be done directly editing the 

Gsolver.ini file with a text editor (such as Notepad) and then restarting 

GSolver. Or it can be done from within GSolver using the Material Editor.  

NOTE: It is recommended that new materials in any model class be added 

to the end of the model section list. When legacy grating structures were 

stored, the material property ass stored as an index into the material list. 

When a saved grating is loaded, materials are loaded by index, not by name. 

Therefore, if materials are rearranged by editing the INI file, this might 

affect the properties of a saved grating. If needed, multiple copies of the 

material (INI) file can be used. Copy the needed file into the root directory 
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(where the exe is located) before starting GSolver. GSolver reads the INI 

from the root directory. If one is not found there a new one is created with 

minimal entries. 

The material model parameters are stored in the GSolver.ini. This text file 

can be edited with a text editor such as Notepad. Described below are the 

various material models, their parameterizations and representation within 

GSolver. 

2.7.1 Models 

GSolver currently has six index of refraction models: Constant, Drude, 

Sellmeier, Herzberger, Schott, Polynomial, and Table. Of these models, the 

Constant, Drude, Polynomial, and Table give complex indices of refraction; 

the others are real valued. The Table model offers the most flexibility as the 

entries may be made with a wavelength resolution as fine as desired.  

Each model has approximate validity over a continuous, finite range of 

wavelengths. The user must assure that the wavelength values remain 

within the valid range throughout the diffraction calculations as GSolver 

makes no check on ‘index of refraction validity.’ 

2.7.2 Constant 

The Constant material property returns a fixed index of refraction for any 

wavelength setting. A Constant material property is specified with a name 

and real and imaginary indices of refraction. In the INI file these appear as 

name: real value, imaginary value 

The colon after the name serves as a text (name) delimiter. 

2.7.3 Drude 

The Drude model is a well-known, simple analytic index of refraction 

model based on a simplified physical two parameter model of the material. 

It is not expected to give accurate results at any wavelength, particularly 

above the first model resonance. 

A Drude model material is entered as 

name: p1, p2 
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Where p1 and p2 are the two real model parameters. The relation between 

the parameters and the model index of refraction is as follows: 
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where  is the wavelength in microns. The square root branch is taken so 

that n and k are positive quantities. (All n and k in GSolver are treated as 

non-negative quantities.) Typically, a Drude model might be used to 

estimate indices of refraction for metals in the infrared region. 

2.7.4 Sellmeier 

There are several Sellmeier models in the literature, and GSolver’s 12-

parameter Sellmeier model comprehends several of them. A Sellmeier 

material is entered as a name followed by 12 comma-delimited parameter 

list. For example, 

BK7: 0.5, 1, 1.03961, 0.231792, 1.01147, 0, 0, 0.0060007, 

0.0200179, 103.561, 0, 0 

gives the Sellmeier formulation for the common glass BK7. The index of 

refraction is calculated according to the following formula 
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where the c’s are the various model parameters, and  is wavelength in 

microns. (The internal GSolver representation of wavelength is in microns, 

as are all quantities with length units.) C2 is the first parameter following 
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the name, and C3 is the second parameter. C4+i are the next 5 parameters, 

and C9+i are the final 5 parameters. 

This model is purely real. Since it does not estimate the imaginary part of 

the index of refraction, k is set to 0 for Sellmeier materials. 

2.7.5 Herzberger 

GSolver’s Herzberger model is a 20-parameter real index of refraction 

model. A typical INI file entry for a material of Herzberger type is shown: 

MgO(IRTR-5): 1, -0.00309946, -9.61396e-006, 1.72005, 0, 

0.00561194, 0, 0, 0, 0, 0.028, 0, 0, 0, 0, -1.09862e-005 

where the name, Mg0(IRTR-5) in this example, is followed by the 20 

comma-delimited model parameters. 

The index of refraction is calculated according to 
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There is no parameter labeled c1 so the first list entry starts with c2. 

This is a real index of refraction model; the imaginary part of Herzberger 

model is set to 0. 

2.7.6 Schott 

GSolver incorporates a six-parameter Schott index of refraction model. A 

Schott material entry example is shown below: 

BK7: 2.27189, -0.0101081, 0.0105925, 0.00020817, -7.64725e-

006, 4.24099e-007 

This is the Schott model for the glass BK7. 

The index of refraction for the Schott model is calculated according to the 

following formula: 
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where  is in microns and the six parameters are labeled c2 through c7. The 

Schott material model is real so materials of type Schott return k = 0. 

2.7.7 Polynomial 

The Polynomial model allows for tenth-order polynomials to define both 

the real and imaginary parts of an index of refraction. This requires 20 real 

parameters to define a material model of type Polynomial. The basic INI 

gives a few hypothetical materials. For example 

type2: 1.5, 0. 2, 0, 0, 0, 0, 0, 0, 0, 0, -0.1, 0.095, -0.1, 0, 0, 0, 0, 0, 0, 

0 

defines a polynomial model of name type2. The 20 comma-delimited 

parameters are used to calculate real and imaginary indices of refraction 

according to the following formulas: 

9

0

9

10

0

i

i

i

i

i

i

n c

k c





=

+

=

=

=





 

where the absolute value signs assure that n and k are both non-negative. 

2.7.8 Table 

The Table model is the most general material model. It consists of a material 

name followed by a list of entries. Each line in the list consists of three 

numbers: wavelength, n, and k. The wavelength is in microns. 

If a wavelength evaluation is done at a wavelength that is not in the table, 

GSolver linearly interpolates the table. For example, the following is a 

partial entry for silver (AG): 
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AG:  

0.186412 0.995 1.13 

0.187836 1.00425 1.14938 

0.189282 1.012 1.16 

0.19075 1.0195 1.16813 

0.192242 1.028 1.18 

0.193757 1.0375 1.19438 

0.195296 1.048 1.21 

0.196859 1.05963 1.22563 

0.198448 1.072 1.24 

0.200063 1.08481 1.25125 

0.201704 1.098 1.26 

0.203373 1.11163 1.26563 

0.205069 1.125 1.27 

0.206793 1.13719 1.275 

0.208547 1.149 1.28 

0.210331 1.16144 1.28531 

0.212146 1.173 1.29 

0.213992 1.18188 1.29281 

0.215871 1.19 1.295 

For a wavelength selection of 0.20, for example, the table value entries at 

0.198448 and 0.200063 would be linearly interpolated.  

2.7.9 Color Map  

Indices of refraction, both real and imaginary parts, are represented by 

colors on the Editor canvas. The two colors are given as a background and 

a cross-hatching pattern. Assigning of the colors is through a user-definable 

color map interpolation scheme. 
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The Color map has two components, lists of piecewise-linear breakpoints 

through RGB space for both the real and imaginary components of the index 

of refraction. Break points may be added and deleted from the list. 

For example, given n, as the real part of the index of refraction, a search is 

made through the real breakpoint list to find the two break points that 

bracket n. These two points define two RGB coordinates. The color of the 

given n lies along the line between these two points in RGB space as a linear 

interpolant. The same goes for the k value with the list of imaginary 

component break points.  

This scheme allows for general color assignments to the real and imaginary 

parts of the index of refraction. The representation of the colors is done with 

a two-color fill pattern made up of a cross hatch against a solid background. 

Changes to the default color map are stored with the grating in the gs5 file. 

Therefore, when starting GSolver, each new grating has the default values. 

To use modified values simply save a simple grating as a gs5 file. Loading 

that file will change the color map to the saved settings. 
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2.8 Materials Editor 

The Materials Editor Dialog, as shown in the figure, provides a graphical 

editing tool for the material catalog items. Any changes made using the 

Materials Editor do not get written to the GSolver.ini disk file until the 

current version of GSolver is closed. However, the internal materials tables 

that are created, by reading the GSolver.ini file when GSolver starts, are 

modified, and any changes are available for immediate application.  

There are two sets of edit buttons on the bottom of the dialog (Insert, 

Replace, and Delete). The first set applies to all materials. The second apply 

to the table entries themselves in a line-by-line fashion.  

The first step in editing a material is to select a model from the drop down 

list box; the next is to select a specific material. The selected material 

properties are then loaded in the large list box (for Table Models) or in the 

Edit box for the other materials.  
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Make any modifications to the material parameters in the edit box and select 

the edit operation desired: Insert to add it to the model list; Replace the 

current material selection; Delete to remove the current selection. 

For the Table Model materials, the second set of buttons are used to edit the 

list, and the first set of buttons are used to update the Table material object 

in the Table catalog. 

The Chart provides a graph of the currently-selected material and any 

changes.  

2.9 Types of Saved Data 

There are three types of data files that can be created, saved, and loaded 

within GSolver: First there is the grating definition file itself with all the 

related data structures and parameters. This is a binary file of type gs6.  

The second type of data file contains the saved contents of the various grids: 

Listing/Run, GA, and Results. The grid contents are saved as TEXT and can 

be viewed and manipulated by any text editor. The contents of the grids can 

be saved and loaded, allowing for archiving various data runs based on a 

single grating definition. They can also be loaded into other programs for 

further analysis. Additionally, one may choose to write all the complex E-

field components for all Orders to a TEXT. The fields are computed during 

a RUN, and relate to the field amplitudes for each order at the top 

(superstrate) and bottom (substrate) of the grating interfaces. The fields may 

be analyzed (outside of GSolver) to ascertain phase information. 

The third type of file supports exporting the graphs. The graphs are 

generated with the ProEssentials© graphics interface. These graphs can be 

exported in a variety of formats.  

. 
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3 Parameters Tab 

This chapter describes the various data fields and controls on the Parameters 

tab form which is shown in the following figure. 

 

The figure in the lower right depicts a schematic of the grating, showing the 

illumination k-vector (plane wave), along with the various diffracted orders. 

If a grating has been entered (from Graphical Editor, or GS4 Editor) use the 
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menu item Tools->3D Grating View to create a snapshot of the grating 

geometry. 

The various Parameter entries are discussed in subsequent sections. 

3.1  Units Selection 

The internal representations of wavelength and grating period are in units 

of microns. For display, different units may be chosen for these quantities. 

Several common length units are available for selection from the Units drop 

down list box. Selecting one of these defines the unit’s conversion factor 

for the display. The bottom selection in the list is ‘User units’. This allows 

configuring the conversion for units not in the drop-down box. If you select 

this item, you should then also enter the conversion factor in the related text 

entry box. 

The two quantities that have units in a grating calculation are the 

wavelength and the period and grating feature dimensions. The absolute 

(vacuum) wavelength is needed for the index of refraction calculation.  

3.2 Angles 

All angles are entered as degrees. On the Parameters form are four angle 

entries that describe the incident plane wave direction and polarization.  
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Polar angles  (theta, towards negative x-axis) and - (phi) are defined as 

shown in the figure below: 

 is positive for deviation away from the +z axis towards the -x axis.  is 

positive for clockwise rotation around the z axis from the –x axis. This 

convention is for the incident plane wave (k vector) illumination. For the 

reflected components the +x axis is used as a reference.  

X

y

zk
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zk
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The two angles  (alpha) and  (beta) are used to define the polarization 

state. If  = 0 the illumination is linearly polarized. For transverse electric 

(TE) polarization, the principal E-field is normal to the plane of incidence 

defined by k and the z-axis. For transverse magnetic (TM) polarization, the 

principal E-field is in the plane of incidence. 

 is the angular deviation of the principal E-field direction away from TE 

towards TM;  = 0 for pure TE, and  = 90 for pure TM.  

 determines the magnitude of the secondary E-field which is perpendicular 

to the principal E-field and k, and 90 degrees out of phase in time. If the 

principal and secondary E-fields have equal magnitude, the wave is 

circularly polarized. 

In general –45    45. Labeling the principal E-field as E1, and the 

secondary E-field as E2,  is the angle shown in upper right in the figure. 

3.3 Order Convention 

Different coordinate conventions lead to different numbering of the 

diffracted orders. These various schemes arise from choice of the definition 
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of the plane wave vector propagation (±k, ±, and ±i). The order convention 

used in GSolver can be seen in the schematic view on the Parameters, where 
real propagating orders are numbered as shown. 

3.4 Substrate/Superstrate 

All regions of the grating must be assigned a material property. The 

superstrate and substrate material properties are assigned from the 

Parameters tab using the two labeled buttons. The button command opens 

the Material Property Dialog where a material type and entry may be 

selected. 

3.5  Saving 

To Save the current grating use the File→Save menu command. A grating 

file has a *.gs6 file type. If the Listing, Results, or GA form data grid 

contents are saved, use the Grid→Save Grid menu command. Data from 

grids are saved as TEXT (*.txt) files. 
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4 Graphical Editor (Editor Tab) 

The graphical grating editor, as shown below, is the primary tool for 

defining a linear (lamellar) grating structure. Note that crossed gratings 

(3D) are handled separately for both editing and calculation, and are 

discussed in the 3DEditor and 3DRun chapters. 
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The main area is called the ‘Canvas’ where all drawing takes place. The 

canvas represents an edge-on view of the grating. The substrate exists in the 

region below the canvas. The area above the substrate is the superstrate. The 

canvas is the ‘modulation region’ where the grating exists. This is illustrated 

in the following figure. 

 

Once a figure is drawn, using the primitive shapes and automatic profile 

tools, a click on the ‘Approximate’ button in the upper right corner invokes 

the piecewise constant approximation routine. This algorithm examines the 

canvas at each of the canvas grid points and creates a piecewise constant 

approximation, which is the internal representation GSolver uses for 

diffraction calculations.  

If drawing objects overlap, the object on ‘top’ determines the index of 

refraction for that region. If several objects are grouped, the grouped object 

is treated as a single object with the ‘first’ object in the group setting the 

material property for the group. 

The Canvas width is always equal to 1 Period (set on the Parameters tab). 

The Vertical Canvas scale is absolute units in the current, multiplied by a 

user defined vertical scale factor (entered on the form in the upper left). The 

default view shows a ruler on the left ranging from 0 to 10. For microns the 

10 corresponds to 1 micron (times the vertical scale factor). For example, 

assume the Period is set to 1.5 microns. The width of the Canvas is 1.5 

microns, whereas the (default) height of the canvas is 1.0 microns. A quick 

 

Substrate 

Superstrate Canvas 
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way to rescale the height is simply change the vertical scale factor. 

Changing units to say nm, the 10(ruler) = 1000nm.  

You can change the height of the canvas (and width), for display purpose 

using the Edit->Canvas Properties (or Measure button), as different 

monitors have differing pixel pitch. Changing the width, simply changes the 

width viewing area of the Canvas, but whatever the width is, it corresponds 

to 1 Period. Changing the height also allows for greater resolution but a 

reading of 10 on the vertical scale still corresponds to 1 micron.  

4.1 Canvas Coordinate System 

The canvas width is equal to 1 grating period regardless of any adjustments 

made to the viewing size using the Canvas Properties dialog (also accessible 

using the Measures button). One may want to change the viewing size to 

provide higher fidelity in the canvas grid (more ‘dots’ lead to better 

refinement of the Piecewise approximation).  

The canvas origin is the lower left-hand corner. The two rulers that span the 

canvas, on the left and top, represent units relative to the canvas view. The 

substrate lies in the region <0 on the vertical scale, and is not accessible 

from the canvas. (The substrate and superstrate material properties are 

assigned on the Parameters form.) All drawing is done on the canvas.  

The Vertical scale is absolute. Typically, the 10 on the vertical scale 

represents 1 micron (or equivalent to 1 micron in the chosen Units). If the 

Vertical Scale Factor is changed to say 3.2, then 10 represents 3.2 microns 

(or equivalent in the chosen units).  

4.2 Canvas Grid 

The grid spacing is set in the Canvas Size dialog (click on Measures) and 

gives the resolution of GSolver’s piecewise constant approximation. There 

is a minimum grid spacing determined by the monitor. The easy way to 

increase resolution is to simply set the canvas size to some larger value, 

putting more monitor pixels at disposal. 

On the other hand, there is a point beyond which increased resolution has 

no benefit or effect on the outcome of the calculation. This will be grating 
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specific and depends on the relative changes in the material properties 

(index of refraction). A rule of thumb is design to /10 for approximating 
smooth profiles.  

The ‘snap to grid’ feature may be turned on/off from the Canvas Properties 

dialog. This feature attempts to size all components so that boundaries are 

on grid points. This is often convenient for sizing components, but can be 

inconvenient if components have incommensurate dimensions with respect 

to the grid spacing. In this case the snap to grid can be turned off. Note that 

the better place for fine tuning dimensions is on the from the Listing/RUN 

tab, or GS4 Editor tab, where every block feature may be set to any desired 

size. 

4.2.1 Accelerator Keys 

To delete a primitive object on the Canvas, select it and then key shift-del. 

To copy a region, select it and, while holding down the control key, drag 

the object with the mouse. Objects can be dragged from one grating canvas 

to another for multiple concurrent GSolver open objects. 

To copy an object for pasting into another canvas, or any OLE enabled 

application, right click the object and select copy. To paste, right click the 

canvas and select paste. 

4.3 Tools 

Several tools are available for drawing grating profiles and are discussed in 

the following sections. 

When any region is selected, the boundary is augmented with handles (small 

gray squares) that can be dragged to resize the object.  

4.3.1 Rectangle 

The Rectangle tool icon is used to add a uniform layer (thin film). A uniform 

layer is a rectangle that spans the width of the canvas. Or, it may be used to 

add a binary (block) transition region. 
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4.3.2 Piecewise Linear (poly-line)  
The poly-line tool icon is a triangle. A linear poly-line region is defined by 

a starting point, defined by clicking the canvas after the tool selection, 

moving the mouse to a new point and clicking again, and repeating. Each 

click generates a boundary line from the prior click location to the current 

click. Double clicking will complete the region. 

4.3.3 Spline Curve and Ellipse 

The spline curve icon is the kidney shaped command icon. The operation is 

similar to the poly-line tool; however the shape is smoothed by a cubic 

spline estimation through each set of 3 points. Double click to complete the 

figure. 

4.3.4 Classical Form Generation 

This tool invokes a dialog with tools to generate Blaze, General Sawtooth, 

General Sinusoidal, and General Poly-line curves. The tool icon for the 

classical form (custom profile) tool is a black blaze profile (triangle). 
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Use the list box (top left) to select among the several predefined profile 

types. 

Blaze − A blaze profile is defined by a single parameter, the blaze angle. 

Enter the blaze angle in grid location C3 in the dialog (the coordinates of 

the triangle vertices are listed in the X: and Z: labeled columns A and B). 

After the profile is updated, clicking the dialog OK button will insert the 

profile onto the canvas. The canvas size is increased automatically if 

needed. 

General Sawtooth − A sawtooth profile is defined by two sub-ninety-

degree angles. Enter the angles to define the profile in grid locations C3 and 

D3. 

General Sinusoid (poly) − This profile is a generalized sinusoid 

constructed by a piecewise-linear approximation. The number of line 

segments that define the boundary may be set to any reasonable number. 

The default is 15. Enter the number of line segments in grid location D2. 

There are two columns of coefficients, labeled A and B in the equation 

below, with A entries in grid locations C5-15, and B entries in grid locations 

D6-15. The general sinusoid profile is defined by the following formula, 

where A0 is in grid location C5, A1 and B1 are in grid locations C6 and D6, 

and so forth. 

 
=

++=
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)sin()cos(  

Any desired number of coefficients may be used. The table may be extended 

simply by entering nonzero values in grid locations Cn where n>13 and so 

forth.  

General poly-line − This form provides a method for constructing an 

arbitrary poly-line approximation to a general profile. Enter the coordinates 

of the poly-line end points as an (X, Z) pair in grid locations An, Bn starting 

with n=2. All x-coordinate entries must be in the range 0<=x<=1, where 1 

represents one grating period unit. z-coordinate values should be in the 

range z>=0. z is absolute, and 0≤x≤1 (x is scaled by Period).  
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General cubic spline − This tool is very similar in operation to the General 

poly-line. The difference is that every 3 consecutive points are taken as a 
cubic spline definition. Thus, the number of points entered in the table 

should be a multiple of 3.  

These two tools allow for precise point location for both a poly-line and 

spline profile definition. 

4.3.5 Conformal Coats 

Conformal coats are created by selecting 

the profile group or object, copying it, 

and shifting the copy vertically. The copy 

properties are then set, and the new object 

is sent to the back of the view-stack, or the original object is brought to the 

front. This procedure is illustrated with the following example. 

Conformal coat on a blaze profile: 

1. Start a new canvas by clicking on File→New 

2. Click on the custom tool icon; select the blaze profile tool (default), 

and click OK. This puts a blaze profile on the canvas. 

3. Right click the blaze profile object and set the material property 

4. While holding down the control key, click on the blaze profile object 

and drag it up (towards the top of the canvas). This makes a copy of 

the profile object so there are now two on the canvas. 

5. Right click on the new copy and set the material properties to the 

coating material. 

6. Move the copy so that the peak of the copy is a few grid units above 

the original; most of the copy will overlap the original. 

7. Right click on the new copy again and then click on the Order option 

and then Send to back. 

8. You may want to turn off the ‘snap to grid’ property of the canvas 

9. To fill in the small areas at the base of the coating use the rectangle 

tool to create two small rectangles to fill in the area remaining. Use 

the order property to put the new objects behind the original. 

After drawing a grating structure click on the Approximate button to run the 

piece-wise constant approximation algorithm. The piecewise constant 
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approximation, which is the internal representation of the grating for 

purposes of calculation, can be edited for precise thicknesses on 

Listing/Run tab or the GS4 Editor tab. 

4.3.6 Uniform (fill) Coats 

Uniform (fill) coats are made in a similar 

manner to the conformal coats discussed 

above. Simply select the rectangle tool, set its 

properties and size (width as wide as the 

canvas), and then put it at the back off the 

view-order. All other objects will be on top, and any canvas space is now 

covered by the fill material defined by the rectangle object. 

4.3.7 Text and Lines 

For convenience GSolver contains text and line tools that can be used to 

annotate grating structures on the canvas. Text and line tools do not have a 

material property, and should not be used as part of the grating 

approximation. They do have a color property, but this is not tied to any 

particular material.  

However, if it happens that a line or text object intersects a grid point, it is 

possible that the piecewise constant approximation algorithm will assign 

some (undefined) property to that location. Therefore, the text and grid lines 

should be used for annotation only; if they affect the piecewise constant 

approximation algorithm they should be either temporarily covered (sent 

behind something), moved slightly, or not used. 

4.4 Automatic Piecewise Approximation 

Once the grating profile is drawn it is necessary to run the piecewise-

constant approximation algorithm on the grating objects. This is 

accomplished by clicking on the ‘Approximation’ radio button in the upper 

left-hand corner of the canvas area. The approximation is recalculated each 

time this button is clicked. 

The algorithm begins operation by scanning through all the grid points on 

the canvas, filling an array with the material properties of any object it finds, 
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always using the top-most object for overlapped regions. If there is no object 

found it fills the sampling array with the superstrate property.  

In the case of grouped objects, the material property that gets assigned is 

the first object in the group list. Thus, it is important to keep track of which 

objects are grouped, and it is good practice to only group objects of like 

material property.  

Once the sampling array is filled it is then parsed. The array is scanned by 

columns and rows to find the maximum rectangle (grouped sampling 

points) that satisfies the piecewise constant approximation. For example, if 

every grid point happened to have a material property different from any 

nearest neighbor, then the result would be a maximal set of squares centered 

on each grid point. If adjacent grid cells in a single row have the same 

material properties, then the boundaries between them are removed. 

Columns are scanned before rows. Any adjacent rows that are identical are 

combined into one row of twice the thickness. 

Since the sampling is done at the grid spacing, it is convenient to leave the 

snap to grid property turned on. Some experimentation with a grating 

structure will indicate what feature size is required for accurately estimating 

the diffraction efficiency. 

 

4.4.1 Grating Representations 
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There are four internal representations of the grating structure. The 

following is an overview of their interrelationship, and indications of which 

representation is sent to the solver routines to calculate the diffraction 

efficiency. [See sec 1.2 figure for additional detail] 
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The Canvas (on the Editor Tab) contains a list of geometric primitives, and 

represent the grating structure (within a single period). No diffraction 

efficiency calculations are done using the list of geometric primitives. 

 

Whenever the Approximate button is clicked, the list of geometric 

primitives is converted to a piecewise constant approximation. This internal 

representation is the basic grating description which is passed to the solver 

routines. For example, working from the Run tab, clicking the RUN button 

will invoke the solver routines with the grating structure which results from 

the Approximate function. 

 

Two other grating representations are also created, one for the Listing/RUN 

tab and also for the GA tab. In both cases the Populate function copies the 

results of the Approximate function representation to the respective grids. 

 

When the RUN (Listing/RUN tab) and RUN GA (GA tab) buttons are 

pressed, the solver routines are invoked with the grating definition given on 

their respective grid (the grid description is first copied to the internal RUN 

array). 

 

To copy modifications made on the Listing/RUN grid (or the GA grid) to 

the internal grating definition data structure simply click the Copy/Update 

button on the grid.  

 

If you make modifications to the grating on (say) the Listing/RUN grid, and 

then want to use those modification to do a GA run, you will need to first 

Copy/Update the Listing/RUN grid (to update the Approximate data 

structure) and then Populate the GA grid.  

 

4.5 Holographic Tool, VH, SH  

VH is used to generate volume holograms with fringes close to the normal 

direction to the grating. SH is used to generate a fringe pattern parallel to 

the grating (a Bragg reflector). SH creates a series a thin film slabs, in the 

piecewise approximation, whose index of refraction varies periodically.  
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The VH tool (button VH) assumes that some material (base index) has some 

density modulation. The modulation is defined by a sinusoidal variation. 

The index of refraction is given by  

𝑛(𝑥, 𝑧) = 𝑛𝑏𝑎𝑠𝑒 + 𝑛 ∑ 𝐴𝑗 𝑠𝑖𝑛( 2𝑗𝜋𝑥 + 𝑠𝑧 𝑡𝑎𝑛( 𝜙)) +𝑗=0

                                                            𝐵𝑗 𝑐𝑜𝑠( 2𝑗𝜋𝑥 + 𝑠𝑧 𝑡𝑎𝑛( 𝜙))
𝑚𝑜𝑑

  

where nbase the base index of refraction, and nmod the modulation index. The 

period is normalized (one grating period), and s=2/thickness.  is the so-

called slant angle and causes modulation in the z-direction. When  = 0 

only one layer is needed. 

The general index is then discretized into the number of layers chosen and 

also the number of steps within each layer. This a piecewise approximation 

to the index variation.  

The SH tool (button SH) is used to generate a fringe pattern that is parallel 

to the substrate. The index of refraction is given by 

  
mod

0

( ) sin 2 cos 2
base j j

j

z z
n z n n A j B j

T T
 

=

   
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  

where n(z) varies in the normal direction only and T is the layer thickness.  

Since GSolver is material oriented, the various constant regions within a 

holographic layer are assigned the ‘constant’ material property, independent 

of wavelength. The material catalog is updated with as many constant 

material regions as called for. When Vh, or Sh are invoked, GSolver first 

looks through the Constant material list to see if a material already exists 

with the required index of refraction. If one is not found a new material is 

created and appended to the list. When GSolver is exited, the GSolver.ini 

material catalog file is rewritten with the new materials. 
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5 GS4 Editor 
 

The GS4 Editor is shown in the following figure. 

 

 

 

This editor operates directly on the internal discrete approximation, and 

each layer in the grating may be displayed in the graphic window on the left 
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by scrolling through the layers, starting at the substrate (0). A layer consists 

of various regions with each region identified by a width (relative to a 

period) and an index of refraction. Each ‘block’ in the layer can be directly 

edited by clicking on and dragging the boundary lines (or after selecting a 

boundary line by clicking and dragging it), or simply entering the relative 

location in the text box. 

 

Boundary lines are numbered from left to right. Each boundary is limited 

by the position of the boundary on the immediate left and immediate right 

(as will show up in the text box just above Current Layer). A boundary may 

not be dragged past an adjoining boundary. 

 

To edit the material, simply double click the region to bring up the material 

selection dialog. 

 

There are two layer delete options: Del current, removes the current layer 

from the grating, and Del All removes all grating layers. 

 

The layer thickness is also indicated and may be edited directly (absolute 

units). 

 

Two tools are available to insert grating layers. To insert a single layer, use 

the N_x button, which inserts a layer with N transitions. To insert a grating 

profile (such as triangle, blaze, or some sort of linear profile) use the N-ties 

button. The ‘ties’ refers to the number of piecewise linear parts there are to 

the profile (1≤ties≤3). 
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5.1 N-ties Profile Tool 

 
 

The N-ties Profile tool is shown in the figure above. A linear profile may be 

defined (up to three linear sections) by clicking and dragging the tie points. 

The relative location of the tie points are shown in the location text box. 

Note that the width is relative to the Period, and the vertical dimension is 

relative to the Total thickness entry. That is the, maximum vertical 

position drawn in the figure is set to Total thickness.  

 

The linear profile represents a partition between two regions defined by the 

‘top’ and ‘bottom’ index of refractions.  
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6 Listing/Run Tab 

The Listing/RUN tab is shown below. Clicking on Populate will load the 

current piecewise constant grating structure to the grid. The grid host a 

powerful computation engine similar to Excel®.  
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Click on the Listing/RUN tab and populate the grid (assumes that some grid 

has been drawn on the canvas in the Graphic Editor, and Approximated). 

The grating structure is found in column B together with the grating 

parameters. Column A is used to label the column B entries. On the right of 

the grid are a group of controls used for setting the free parameter. Column 

C displays the cumulative thickness at each layer, for information purposes.  

Layer 1 is the first layer of the grating structure and interfaces to the 

substrate. Each subsequent layer lies on top of the previous layer. 

Any empty grid cell can be used to hold intermediate results. The grid 

supports split views for both vertical and horizontal splitting. 

Grid-specific menu items are grouped under Format, Formulas, View and 

Grid. Many of the controls operate on specific elements of the grid. In those 

cases, the element must be selected before the controls are activated. 

 

6.1.1 Make Grid Current 

Tools→Make grid current copies the current piecewise grating structure 

(including parameters) as represented on the grid to the internal grating 

storage array (or simply click the Copy/Update button in F10). It has no 

effect on the Canvas (graphic representation) of the grating. This allows for 

any updates/changes to the grating structure to be used between the Grating 

Listing tab, the GA tab, and the RUN tab. For example, after a GA run, the 

resulting grating structure can be copied into the general grating storage 

array, after which a RUN will use the results of the GA run.  

6.2 Parameter Control 

The Listing/RUN grid is equipped with a single parameter located in cell 

D5. This cell can be incremented and decremented, by the increment value 

in cell E5, using the button controls in E7 and F7.  

When the RUN button is clicked, the parameter in D5 is incremented by the 

amount in E5 until it equals or exceeds the stop value set in F5.  
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The order of operation of GSolver when the RUN button is clicked is to first 

increment the D5 parameter from its current value, update all formulas, and 

continue through to the Stop condition. All formula dependencies are 

calculated, but error checking is minimal. D5 is then reset to the starting 

value and the parameter loops through its range again, this time taking the 

Listing values in column B, and running the related diffraction calculation 

for each increment of D5. 

The following example assumes that a grating structure has been defined 

and populated on the listing grid, such as the coated blazed grating example 

given in 4.3.5. 

 

6.2.1 Using Listing/RUN to find the diffraction efficiency as 

a function of incident angle (theta) example. 
 

1. Populate the grid by clicking the 

Populate button 

2. Enter the following formula into cell 

B2: =D5 

3. Enter 0 into cell D5, 1 into cell E5, 

and 80 int cell F5 

4. This formula and set up will change the value of the theta parameter 

from 0 to 80 in steps of 1.0 degrees. 

5. Click RUN 

The D5 parameter runs through its range, updating cell B2, and then is reset 

to the starting value. The loop is repeated, this time running the diffraction 

calculation. The progress bar estimates the time to completion.  

At the end of the calculation the results tab is activated automatically.  

6.2.2 Abort Button 

It is possible to set up grating structures that take a very long time to allocate 

memory and run the defined calculation. The Abort button attempts to stop 

the loop. However, the calculation only responds to the abort message at 

certain convenient places. For example, if the operating system is off trying 
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to allocate sufficient RAM the abort will not happen until the OS returns 

from that activity.  

6.2.3 Example of varying the thickness of the grating 
1. Populate the grid by clicking the Populate button (assumes you have 

defined a grating with the Editor) 

2. Select the Thickness Formula tool using menu item Grid→ 

Thickness Formula 

3. On the Thickness formula dialog click on the All button. This tells 

GSolver that the formula should be entered in every layer thickness 

cell on the grid. If you only want to vary the thickness of  some of 

the layers, then click to deselect other layers from the list. A selected 

layer is indicated with a ‘+’ sign. 

4. I assume that the grating has 20 layers. Enter the following into the 

entry text box on the dialog 

=D5/20  

5. Click OK. The grid layer cells should now be populated with the 

formula =D5/20. To check the result increment or decrement the 

parameter in D5 or simply have the Grid show all the cell formula 

entries using menu item Formulas→Formula Expressions. 

6. Enter 0 in D5, 4 in D6, and .05 in D7 

7. Click RUN. The total grating thickness is varied from 0 to 4. 

6.2.4 Example of Littrow constraint 

The Littrow condition constrains the incident angle (Theta) by the 

wavelength-to-period ratio. One way to implement this constraint is  

 Theta = asin(lambda / 2*Period)  

Additional checking should be done to ensure that the argument of the asin 

is correct, and that |Theta|<90. The example below shows one way to 

implement a Littrow condition constraint using the wavelength as the free 

parameter (fixing the Period). If this example is worked following the 

previous example, clear the layer thickness formulas by using the dialog 

tool to enter the formula =0.05 in all the layer cells. 

1. Populate the grid (if needed) 

2. In cell B6 (the wavelength parameter) enter 

=D5/100+1 
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3. In cell B2 (Theta cell) enter 

= degrees(asin(if(abs(B6/(2*B7))<1,B6/(2*B7),0.))) 

4. Enter 0 in D5, 1 in D6 and 99 in D7. This will change the wavelength 

from 1 to 1.99 microns. 

5. Click RUN 

6. Another way to constrain this formula is as follows: 

    =degrees(asin(if(abs(B6/(2*B7))<1,B6/(2*B7),0.))); #>=0 && #<90 

Details on using the grid calculation engine are given below (6.4). 

6.3 Cell List 

Cell F15 contains the label ‘Cell List’. Any cell designation (such as B2, 

C12, G23, etc.) that is entered in the column below F15 will be included on 

the Results List.  

For example, assume that you want to include a listing of the contents of 

cell B2 (theta, which may be the results of a formula calculation) on the 

Results listing. Simply enter  

B2 

in column F below the ‘Cell List’ label. During a Run cycle, GSolver scans 

down column F (starting at row 16) for a list of cell designations. Then for 

each parameter update it records those current cell contents on the Results 

listing. This provides a way to include any grating definition results in the 

Results listing for additional analysis. 

6.4 Formula Engine 

Any cell entry that begins with an equal’s sign (=) is interpreted as a 

formula. Each formula is evaluated immediately and the results are shown 

in the same cell. To expose the formula scripts of a cell, select it and use the 

menu item Formulas→Formula Expression. 

Formulas are limited to 512 characters. Formula recursion is not supported. 

That is, a formula cannot depend, either directly or indirectly, on its own 

output value. 
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All calculations are done in double precision. Calculations with logical 

operators (!, &&, ||, ?:) consider a non-zero value as TRUE and a zero value 

as FALSE. 

Integer operators (~, &, |, ^, %) convert their argument(s) to integer first.  

The maximum number of grid columns is 4096. The maximum number of 

grid rows is one million.  

Entries that begin with the apostrophe character are treated as text.  

Covered cells cannot be altered. This feature is used on any cell that 

contains labeling information. 

Do not use commas or spaces to delimit pure numbers. Scientific notation 

(E convention) is supported.  

A range of cells can be referenced absolutely such as A2..A10. Cells may 

also have relative references. 

6.4.1 Syntax 

In general, a formula will have the following syntax 

=expression; constraint expression // comment 

where expression defines the calculations, constraint expression places 

limits on acceptable values or circumstances under which the calculation 

should take place, and comment may be any text. It is recommended that 

constraints be entered using the if(. .) function, otherwise the grid will 

generate an information dialog each time a constraint is violated. 

6.4.1.1 Expressions 

Expressions are algebraic formulas comprised of values and operators that 

define the relationships between values. They adhere to the following: 

• A formula must begin with an equal sign  

• The grid automatically assumes you are typing a formula if you 

begin with any of the following characters 

0 1 2 3 4 5 6 7 8 9 . - @ = + 

• Spaces are ignored but count against the 512-byte limit 
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• Ranges look like B12..G29, A1..D5 

Operators (and order of precedence) 

 %   14  Unary percent 

 **  13  Exponentiation 

 +    12  Unary plus 

- 12  Unary minus 

 ~    12  Bitwise complement (integer) 

 !     12  Logical not 

 *    12  Multiplication 

 /     11  Division 

 %   11  Remainder (integer mod) 

 +    10  Addition 

- 10  Subtraction 

 <<  9  Shift left (bit shift on integer) 

 >>  9  Shift right (bit shift on integer) 

 <     8  Less than 

➢  8  Greater than 

 <=  8  Less than or equal 

 >=  8  Greater than or equal 

 ==  7  Equal 

 !=   7  Not equal 

 &   6  Bitwise And or string concatenation 

 ^    5  Bitwise XOR (integer) 

 |     4  Bitwise Or 

 && 3  Logical And 

 ||     2  Logical Or 

 ?:    1  Conditional (like the C language conditional) 

In formulas with more than one operator, the grid formula evaluates 

operators in the order of precedence presented above, with highest 

precedence first. That is, AND/OR/NOT operators are evaluated 

after inequality operators in a logical expression, and 
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multiplication/division operations are performed before 

subtraction/addition operations in an arithmetic expression. 

Operators at the same precedence level are evaluated from left to 

right. 

Indirect Reference 

An indirect cell reference specifies a row, column offset from the 

current cell location with the follow syntax: 

#{column offset, row offset} 

• If one value is included, the grid formula assumes that it is a column 

offset. For example, the offset reference #{-1} tells the grid formula 

to look to the column just left of the current cell. 

• Offset values may be constants or expressions 

Examples: 

• #{0,-1} refers to the cell above the current cell 

• #{-2} refers to the cell two columns to the left of the current 

cell 

• #{1} refers to the cell to the right of the current cell 

• #{0,1} refers to the cell below the current cell 

• @CSUM(C4..C100, #{-1} == "Joe") calculates the sum of all the 

values in the range C4..C100 for which the cell in the column to the 

left contains the string "Joe". 

• @CCOUNT(C4..C100, # #{0,-1}) counts all the cells in the range 

C4..C100 whose value is greater than the contents of the cell 

immediately above. 

• /verb/#-1+2/ adds 2 to the cell value from the cell to the left. 

6.4.1.2 Constraint Expressions 

Constraints are limitations or conditions placed on the variables in the gird. 

They are expressed as algebraic statements appended to formulas. A 



GSolver V6.1 User guide 

65 

constraint expression can be attached to any formula, by typing a semicolon 

(;) and the constraint conditions after the formula. 

Constraint expressions establish either conditions under which a formula 

operates, or boundaries for valid results of the formula. Constraint 

expressions can be simple equality/inequality relationships, or arbitrary 

formulas. Any valid grid expression that returns a numeric value is a valid 

constraint expression. However, unlike the expression that defines a cell 

value, a constraint expression can reference the cell in which it resides, by 

using the symbol #. For example, the formula =A1 + A2 ; #>2 && #<=B5 

|| #==C7 means: the value of the current cell is the sum of cells A1 and A2, 

and that value must be either greater than 2 and less than or equal to the 

value of cell B5, or equal to the value of cell C7. The benefit of constraint 

expressions is maximized when combined with current cell reference 

support (#) as indicated in the above example. 

Constraint violation generates an error dialog box, and so can be 

inconvenient in loops. An alternative is to us the if(*,*1,*2) function. This 

function returns *1 if the condition in the first slot is true, otherwise it 

returns the result in *2. For example 

=if( d5/100>-90 && d5/100<90,d5/100,0) 

will return the value d5/100 if it is between -90 and 90, otherwise the 

function returns 0. 
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7 Genetic Algorithm (GA Tab) 

The GSolverV6.1 genetic algorithm has been enhanced. It is derived from 

Differential Evolution (DE), a class of genetic algorithms for which there is 

a large literature. More information on Differential Evolution is given here: 

https://www.icsi.berkeley.edu/icsi/node/2684 

 

https://www.icsi.berkeley.edu/icsi/node/2684
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The GSolver DE implementation allows for an arbitrary number of real 

parameters, and several popular evolution strategies. However, some care 

is required to find a particular grating efficiency solution. If the solution 

constraints are too far afield of any physical solution, the algorithm is likely 

to simply wander around in parameter space and never produce a 

satisfactory result. The application of DE to grating design is a very 

powerful tool for optimization.  

This chapter explains DE and how it applies to grating design. 

7.1 Overview of Differential Evolution 

DE parameterizes optimization problems. A specific set of parameters (a 

vector) is associated with a merit function whose extremum is to be found. 

A set of parameter vectors is a population. The algorithm will alter various 

population member entries with other entries, as well as creating new entries 

from random distributions. Population members with ‘good’ merit 

functions are chosen more often than others to serve as a source of 

parameters. New vectors are made up with these ‘good’ parameters as well 

as new random members and the entire set is iterated until some stopping 

criterion is reached. The key idea is to apply various geometric constraints 

to grating dimensions, and find the best dimensions to satisfy some global 

merit function (such as maximize some diffraction order as a function of 

some range of angles or wavelengths). 

7.2 Guiding Principles 

Applying DE to the grating problem requires some care. For example, 

careful attention to physical constraints is required to produce meaningful 

solutions. In particular, the total width of all blocks in a layer must some to 

1.0 (one Period). 

In addition to the grating geometry parameters, the global parameters may 

also be used. These include grating period, wavelength, thickness, and the 

angles that define the illumination plane wave. 

The actual material properties in any cell are problematic. Since GSolver 

ties all indices of refraction to an actual material in a catalog, it is difficult 
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to allow arbitrary changes in these indices. Thus the index of refraction is 

not currently available in the GA.   

7.3 Setting GA Options and Merit Function 

The DE options and merit function are set in a dialog, shown below, which 

is invoked by clicking the Options button (cell F17 on the default GA grid). 
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The Population, Weight, Cross-over, and Max Iterations control the 

operation of the DE run. The number of real parameters (must be at least 1) 

is also entered on this dialog. Select the solution mode from the drop down 

list box. 

The Goal settings area of the dialog contains controls for generating input 

to the DE metric function which will be minimized. The DE merit function 

is as follows: 

( ) −=
2

igoalcalci
DEDEwmerit  

where the sum is over the diffraction efficiency (DE) by orders given in the 

Goal settings. Each term in the sum includes a weight factor, which is also 

entered in the Goals Setting box.  

Enter the goals in the dialog by entering an order (R and T for reflection and 

transmission) together with a weight and goal and add the selection to the 

list. Usually, a merit function consists of one or two DE goals. The object 

of the DE algorithm is to find parameters that minimize the merit function 

(a perfect match is at merit = 0). Additional, one may include a range of 

some global parameter over which the DE is calculates the merit function. 

In the case where Integrated Merit function option is used, the merit 

function (shown above) is simply summed over the range of global 

parameters chosen.  

The GA grid contains the same functionality (formula engine) as the 

Listing/RUN grid (see section 6.4) 

7.4 Applying Constraints 

The GA parameters are selected from a uniform random population, given 

by Min Value and Max Value, for each parameter in the list.  

Each formula should also have a constraint on the chosen parameter so that 

the result gives a physically-realizable value. For example, if a cell width is 

to be altered, you must enter a constraint on the other cells in that grating 

layer so that that total width (sum of all the cells in a layer) sums to 1. 

Following are a couple of examples. 
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7.4.1 GA Design of a Thin Film AR Coating 

In this example the optimal AR (antireflection) coating thickness is sought 

for MgF2 on an Al2O3 substrate in air at normal incidence at 0.5 m 

wavelength. 

1. Start a new grating editor  

2. Change the wavelength to 0.5 m on the Parameter tab 

3. Change the Substrate material to Table: Al2O3 

4. Using the Rectangle tool in the Editor tab, create a thin film coating 

with width of the canvas and of arbitrary thickness. 

5. Set the material property to Table: MgF2 

6. Click the Approximation button which creates the piecewise grating 

data structure 

7. On the GA tab click Populate 

8. On the GA Options dialog, click the Options button, enter the 

following goal (0 reflectivity of the R0 order) 

0 R 0 1 (click Add) 

9. This indicates that the specular reflection has 0 energy goal−the AR 

condition. Click OK. 

10. In cell B12 enter the following formula 

=if(F5>0&&F5<0.2,F5,0) 

11. Change E5 to 0.4 

12. Click the GA test button to exercise the parameter selection and 

verify that the thickness is being updated, and constrained. 

13. Click RUN GA 

14. The merit function (Best Energy) is updated each time a new 

minimum is found. The final result is updated to the listing. The 

result should be somewhere around 0.09. 

While the GA is running, the current generation and best merit function are 

displayed. A merit function value of 0 indicates that an optimal solution has 

been found based on the goals given. 

Upon completion the GA loads the values of the best parameters to the grid 

and creates a table of all the diffraction orders (-Orders to +Orders for T & 

R). 
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This example is easily extendable to include multiple thin film layers. 

Simply add the materials in the Editor tab and use a separate parameter for 

each layer thickness. 

7.4.2 GA Design Example 2 

This example considers a sawtooth profile, such as might be cut by a DPT 

(diamond point turning) machine, in ZnSe. The problem is to find the 

optimal sawtooth profile (depth and period) to maximize transmission in the 

1T order for 3 m wavelength, TE polarization, and for 30° incident light. 

1. Start a new grating 

2. Change the wavelength to 3 and the substrate material to 

Herzberger: ZnSe(IRTR-4) and check the Lambda change update 

box. (This tells GSolver to update the index of refraction if the 

wavelength changes.) 

3. Change Theta to 30 

4. From the Editor tab, change the canvas properties (Measures) so that 

Horizontal/Vertical Canvas units (grid) is 0.2.  

5. On the Editor tab, select the Custom Profile tool (black triangle) 

6. Select the General Sawtooth form, and change the angles to 35 and 

90. Click OK. 

7. Select the newly created object and set its properties to Herzberger: 

ZnSe(IRTR-4). This should be the default if the substrate material 

was set. 

8. Click the Approximation button 

9. Click the GA tab and Populate the grid, and scroll down to see the 

number of layers (should be 50) 

10. Click the Options button and enter/Add the goal as 1T 1 1 (1T order, 

DE of 1, weight of 1). Add a second constraint for 0T 0 1 (0 energy 

in to T0 order). Click OK 

11. In cell B7 enter the following formula 

= f5                                   

12. Change D5 to 5 and E5 to 25 (search for optimal solution for period 

between 5 and 25 microns) 

13. Scroll down the grid and find the number of layers in the grating 

structure (this example assumes layers = 50). 
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14. Click the menu item Grid→Thickness Formula, select All and enter 

the formula 
=f5/50 

15. Set D6 to 0, and E6 to 5 (look for a solution for grating depth 

between 0 and 5 microns). 

16. Set B10 (orders retained) to 8 

17. Set D6 to 0 and E6 to .2 

18. Click RUN GA 

While the GA is running, the current generation number is displayed 

together with the best merit function value. A value of 0 indicates that the 

goals were met perfectly. 

For this example, a total thickness of about 2μm, and period of 25μm 

maximizes energy in the 1T order with approximately 70% efficiency.  

At this point click the Copy/Update button so the GA result is available for 

further analysis. Click over to the RUN tab and do a RUN on Wavelength 

(from 2 to 4μm).  

You may wish to change the mode settings under GA Options to examine 

the behavior of different DE evaluation schedules. 

In this example the Period max’ed out at 25μm early in the GA Run. This 

may indicate that there is a better solution for a grating period >25μm.  

Following is a modification to the above example to find the best grating 

for simultaneously maximizing transmission, in the 1T and –1T, for 

thickness, period and angle of incidence.  

 

1. Enter the following in B2 

=F7 

2. Enter -50 in D7 and 50 in E7 

3. Change the goals on the Options dialog to  

1T 0.5 1 and -1T 0.5 1  (and 0T 0 1, to limit the T0 order) 

4. Click RUN GA 
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A typical run will drive theta to 0 deg, the Period to about 5μm, and the 

depth to 3μm. A Copy/Update and RUN on Theta will show that the -1T 

and +1T diffraction curves (as a function of theta) are increasing counter to 

each other (the grating is asymmetric), thus if -1T is generally increasing 

+1T is decreasing. This leads to the normal incidence solution.  

The GA facility provides a powerful tool for grating design and 

optimization.  
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8 Execution (RUN Tab) 

The RUN tab provides DE curves to be generated on several key 

parameters.  

 

8.1.1  Run Constraints 

Select a parameter and enter the start, stop, and increment values for it. 

Click on RUN to start the calculation. The STOP button puts a message in 

the queue to terminate the loop. The loop will stop at the first convenient 

break point. When the RUN is finished the Results tab is activated with 

results written to the Results grid as they are computed.  

8.1.2  1st order Littrow 

The 1st order Littrow check box invokes a simple Littrow condition. As the 

wavelength changes, Theta is altered so that the first-order Littrow 
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condition (in reflection) is satisfied. A Littrow constraint is run as a function 

of wavelength. 

8.1.3  Write Fields to File 

The Write Fields to File command directs GSolver to record the computed 

complex E-fields for each order (real propagating, and evanescent) as an 

text file. Clicking on this control activates a file save dialog; enter the name 

of the file into which to record the complex E-fields. The data can be saved 

to a new or existing file. If the file already exists the results will be appended 

to it. 

The Complex E-fields are the field amplitudes of every order retained in the 

calculation at the top interface of the grating (reflected fields) and at the 

bottom interface (transmitted fields). In general, orders have non-zero 

magnitude, however they may not be propagating. For a field in some order 

to propagate, the related k-vector z-component must have a real component. 

Grating structures can support large amplitude evanescent fields. These 

fields are essential to obtain a physical (convergent) solution. 

8.1.4 Run/Stop 

The RUN button executes a loop defined by the selected parameter.  

The STOP button simply posts a message to the GSolver message queue to 

halt the current calculation. This is a non-deterministic action and GSolver 

will respond to the STOP command at a convenient point. 
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9 Results Tab 

The Results tab holds the grid where the calculated diffraction efficiencies 

are posted. Reintroduced in GSolver 5.1 is a simple phase calculation which 

is also listed. 

 

The first line of the results grid contains headers that identify each column. 

The general format is #R and #T for diffraction efficiencies where # is the 

order number. 
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If the RUN tab is used to generate the results, the first column is a list of the 

current value of the checked parameter.  

If the Listing/RUN tool is used to generate the results, then the first column 

represents the value of the parameter in cell D5 (see the Listing/RUN 

chapter). 

9.1 Diffraction Efficiency 

The diffraction efficiency is defined as follows: 

( ) ( ) ( )( ) ( ) ( ) * ( ) /
k x x y y z z zRk zinck kk

DE E conj E E conj E E conj E re k k = + +
 

where subscript k = diffraction order, kzRk is the z-component of the kth 

diffraction order (as defined by the grating equation), and R is reflection. R 

gets changed to T for the transmitted orders. Since all orders are represented 

as plane waves, if the z-component of the diffracted k-vector is 0 (or pure 

imaginary), then DE is identically 0 for that order. 

9.2 Graphing 

Select the columns to graph; multiple columns can be selected using the 

shift and control keys along with the mouse. Click the chart button. 

The initial chart uses defaults on all settings. To alter any feature of the 

graph, double click on the graph to invoke the Settings dialog.  

 

9.3 Polarization 

GSolver V6.1 evaluates polarization angles ( ) for each propagating 

diffraction order. These angles are written to the Results Grid. The 

polarization angles are calculated according to: 

For each order take it’s related k-vector (possibly complex) and field, E, 

(generally complex) 

 𝒌 = [𝑘𝑥𝑛, 𝑘𝑦 , 𝑘𝑧𝑛]   𝑬 = [𝐸𝑥, 𝐸𝑦, 𝐸𝑧𝑛]  
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Find the (inverse) transform (some  ) that takes k back to normal 

([0,0,1]) and apply it to E. The resulting E field will have only an x, and y 
component. The find 

  𝛼 = atan (
𝑟𝑒𝑎𝑙(𝐸𝑥)

𝑟𝑒𝑎𝑙(𝐸𝑦)
) ,   𝛽 = atan (

𝑖𝑚𝑎𝑔(𝐸𝑥)

𝑟𝑒𝑎𝑙(𝐸𝑦)
) 

For information on the polarization angles section 3.2 on angles. 

The E-field for normal incidence is given as: 

 

𝐸𝑥 = sin(𝛼) cos(𝛽) + 𝑖 cos(𝛼) sin(𝛽) 

𝐸𝑦 = − cos(𝛼) cos(𝛽) + 𝑖 sin(𝛼) sin(𝛽) 

 The field is then transformed by  

 𝑇(𝜃, 𝜑) = [

cos(𝜃) cos (𝜑) sin (𝜑) sin(𝜃) cos (𝜑)

cos(𝜃) sin (𝜑) −cos (𝜑) sin(𝜃) sin (𝜑)
sin (𝜃) 0 −cos (𝜃)

] 

to generate the incident (illumination) field. 
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10 3D Editor Tab 

Some crossed grating (3D) structures can be analyzed with GSolver 

Coupled Wave algorithm. The 3D Editor is the interface for defining these 

structures. 

 

NOTE: The 3D Editor/RUN functions are independent of all the 2D 

(lamellar grating) functions. Units must be set to MICRONS.  
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10.1  Cautionary note on Solving 3D Structures 

The coupled wave solution is based on solving the truncated infinite 

Eigensystem set of equations developed from Maxwell’s equations by the 

well-known algebraic eigensystem method. This implies that for each layer 

of the grating a full complex general eigenmatrix is solved, followed by a 

boundary condition solver. This process is iterated through each layer, from 

the substrate to the superstrate.  

The size of the eigensystem, including auxiliary memory arrays for holding 

intermediate results (using 64bit floating point structures), is roughly 

estimated as 

8224)12(560)12(1760
2

++++= ordersordersbytes  

For crossed gratings it is 

8224)12(560)12(1760
24

++++= ordersordersbytes  

Notice that for crossed gratings the size of the memory requirements grows 

as orders retained to the fourth power. In addition, both the eigensystem 

solver, and the boundary system solver require a number of arithmetic 

operations that grow roughly as the cube of the size of the arrays. With just 

a few orders retained on a crossed grating, a significantly large eigensystem 

problem must be solved (for each grating layer).  

10.2  Defining a 3D Grating 

GSolver handles all gratings as piecewise-linear approximations. For a 3D 

grating this approximation consists of a unit cell with periodic boundaries. 

This cell has a width of one grating X-period (set on the Parameters Tab, 

along with wavelength, super/substrate index of refraction, angles) and a 

length of one grating Y-period (set on 3D Editor).  

Each unit cell (viewport on the 3D Editor) may be divided into any desired 

number of ‘checkerboard’ regions. Each region is then assigned a material 

property, which gives it an index of refraction. In this way an arbitrary shape 

may be defined, as a piece-wise constant construct. 



GSolver V6.1 User guide 

81 

The basic tool for defining a 3D unit cell is the NxM tool. This tool creates 

an NxM checkerboard with two materials.  

For any layer, any region of the unit cell can be altered by simply clicking 

on it (to select it) then clicking the Material button. A new material may 

then be assigned to that region by selecting a new material. 

The boundary lines between regions of a cell can be moved by dragging 

with the mouse, or altered by entering new values in the X: and Y: text 

boxes at the top of the form. 

The 3D layer structure is numbered starting with the first layer which lies 

on the substrate (substrate is layer 0), and then increasing for each layer 

above. The substrate and superstrate are given thickness of -1, which 

indicates an infinite half space. 

10.2.1 Holographic Tool 

A holographic grating may require 1 or many layers depending on whether 

the modulation of the photoresist has density variation in the z-direction or 

simply in the x-, and y-directions. The tool handles either situation.  

The tool assumes that some material (base index) has some density 

modulation. The modulation is defined by a sinusoidal variation of up to 

10th order. The index of refraction is given by  

𝑛(𝑥, 𝑦, 𝑧) = 𝑛1 + 𝑛2 ∑ 𝐴𝑗 𝑠𝑖𝑛( 𝑗𝑲. 𝒙 + 𝑠𝑧 𝑡𝑎𝑛( 𝜙)) 
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where n1 is the base index of refraction, and n2 is the modulation index. K 

is the in-plane (spatial) k-vector (2x, 2y), and s=2/thickness.  is 

the so-called slant angle and causes modulation in the z-direction. When  

= 0 only one layer is needed. 

The general index is then discretized into several layers and number of steps 

within each layer; the steps are taken equally in the x- and y-directions. This 

creates a checkerboard layer approximation. 

Since GSolver is material oriented, the various constant regions within a 

holographic layer are assigned the ‘constant’ material property, independent 

of wavelength. The material catalog is augmented with as many constant 

material regions as called for. When invoked, GSolver first looks through 

the Constant material list to see if a material already exists with the required 

index of refraction. If one is not found a new material is created and 
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appended to the Constants material list. When GSolver is exited, the 

GSolver.ini material catalog file is rewritten with the new materials. 

10.3  (3D)Sine Tool 

The Sine Tool is used to create an approximation to a crossed sinusoidal 

‘height’ or pillars between the superstrate and the substrate. The boundary 

is between the top and bottom regions. These top and bottom regions do not 

have to have the same material properties as the super- and substrates. 
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11 3D RUN Tab 

The 3D RUN tab is the interface to the full vector crossed grating solver 

routine. 

 

The selected parameter generates a loop structure within which the solver 

routine is repeatedly called. As the solutions are found, they are written to 

the Results tab in the normal way.  

Diffraction efficiencies are just as in the case of linear gratings. Please refer 

to the RUN tab chapter for more information. 
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12 Dialogs 

12.1  Refractive Index Selection Dialog 

The superstrate and substrate materials properties are set with the following 

dialog which is like the material selection property page used to set material 

properties for the Editor canvas objects: 

 

The superstrate and substrate are not represented on the Editor canvas, so 

the color assignments are not relevant. 

12.2  Refractive Index Color Map Dialog 

Every material property has two colors that represent the real and imaginary 

parts of the index of refraction. The mapping between a color and the value 

of the index of refraction is set using the Color Map dialog. 

The dialog contains two lists that represent the range for the real (n) and 

imaginary (k) parts of that index of refraction. Each list is comprised of 

several entries, in increasing order, together with a color defined in RGB 

space (8-bit coordinates). Numbers in the list are called break points. 

The algorithm that identifies a color with an index of refraction entry is 

identical for both the real and the imaginary pars. Following is a description 

of the algorithm for the real part (n). 
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Given a value n, find the two entries in the appropriate list that bracket it 

such that 

 1 2
n n n   

where n1 and n2 are consecutive members of the list. 

Then draw a line in RGB space from the n1 RGB coordinate to the n2 RGB 

coordinate, and find the RGB coordinate for the linear interpolant given by 

n between n1 and n2. The resulting color is used for the n value. 

The Color Map may be altered as needed; break points may be added, 

removed, and changed. The COLOR button may be used to find a specific 

COLOR RGB coordinate.  

Use the Replace, Insert, and Delete buttons, together with the Control 

entries (n, R, G, B) to modify the list. 
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The color lookup list is stored with the grating in the gs6 file. When GSolver 

is started it creates a new color lookup table based on default values. To use 

a custom lookup table, simply save a grating file with the desired lookup 

table. Then, after starting GSolver, open the grating file (gs6) containing the 

desired lookup table and save it to a new filename. 
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13 Material File GSolver.ini 

The materials file, GSolver.ini, holds parameters for Index of Refraction 

calculations for a variety of common materials. The model classes are 

[CONSTANT] 

[DRUDE] 

[SELLMEIER] 

[HERZBERGER] 

[SCHOTT] 

[POLYNOMIAL] 

[TABLE] 

The analytic forms for each of these models is given in section 2.7. 

Following is a description of the ini file. 

The ini file has eight sections, the 7 material class sections and the 

[GSOLVER V6.1] header section. 

Each material section begins with one of the material class names (in 

brackets) as shown above. Following the class name is a line that gives the 

number of members of the class which will be read in. It has the following 

format: 

 total = x 

where x is the number of materials. The ini file may be edited with a text 

editor. If materials are added, or deleted, be sure to update the ‘total =’ line 

otherwise a read error my happen as the total = x is used to validate the read. 

Each time GSolver starts, it reads the ini file found in the GsolverV60 

directory. If it does not find an ini file it creates a minimal list of default 

materials for each class. 

When GSolver exits, it re-creates the ini file. Thus,  if any material editing 

is done within GSolver, the changes are written out to disk when GSolver 

exits.  

Generally, no checking is done on the material parameter entries other than 

n>0 and k0.  
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The recommended material class is the Table model. Table models are the 

most general, and easily extensible. Also, most index of refraction data is 

recorded in tabular form. 
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14 Grid Formula Engine 

Quick-Reference Guide to Built-in Functions 

14.1  Mathematical Functions 

The following lists the supported mathematical functions. 

Function Description 

 ABS(X) The absolute value of X. 

 ACOS(X) The arc cosine of X. 

 ASIN(X) The arc sine of X. 

 ATAN(X) The 2-quadrant arc tangent of X. 

 ATAN2(X, Y) The 4-quadrant arc tangent of Y/X. 

 CEIL(X) The smallest integer greater than or equal to X. 

 COS(X) The cosine of X. 

 COSH(X) The hyperbolic cosine of X. 

 DEGREES(X) Converts the angle expressed in radians to degrees. 

 DET(M) The determinant of the square matrix range M. 

 DOT(R1, R2) The dot product of the vectors R1 and R2. 

 EXP(X) e raised to the X power. 

 FACT(N) The value of N!. 

 FLOOR(X) The largest integer less than or equal to X. 

 FRAC(X) The fractional portion of X. 

 GAMMA(X) The value of the gamma function evaluated at X. 

GRAND( ) A 12th-degree binomial approximation to a Gaussian  

random number with zero mean and unit variance. 

 INT(X) The integer portion of X. 

 LN(X) The log base e (natural log) of X. 

 LNGAMMA(X) The log base e of the gamma function evaluated at X. 

 LOG(X) The log base 10 of X. 

 LOG10(X) The log base 10 of X. 

 LOG2(X) The log base 2 of X. 

 MOD(X, Y) The remainder of X/Y. 

 MODULUS(X, Y) The modulus of X/Y. 
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 @PI The value of pi. 

 POLY(X, ...) The value of an Nth-degree polynomial in X. 

 PRODUCT(X, ...) The product of all numeric values in the argument list. 

 RADIANS(X) Converts the angle expressed in degrees to radians. 

 RAND( ) A uniform random number on the interval (0,1). 

 ROUND(X, n) X rounded to n number of decimal places (0 to 15). 

 SIGMOID(X) The value of the sigmoid function. 

 SIN(X) The sine of X. 

 SINH(X) The hyperbolic sine of X. 

 SQRT(X) The positive square root of X. 

 SUMPRODUCT(R1, R2) The dot product of the vectors R1 and R2. 

14.2  Statistical Functions 

The following lists supported statistical functions. 

 TAN(X) The tangent of X. 

 TANH(X) The hyperbolic tangent of X. 

 TRANSPOSE(M) The transpose of matrix M. 

 VECLEN(...) The square root of the sum of squares of the arguments. 

 AVG(...) The average (arithmetic mean) of the arguments. 

 CORR(R1, R2) Pearson's product-moment correlation coefficient for the 

paired data in ranges R1 and R2. 

 COUNT(...) A count of the non-blank arguments. 

 F(M, N, F) The integral of Snedecor's F-distribution with M and N 

degrees of freedom from - to F. 

 ERF(L[, U]) Error function integrated between 0 and L; if U is specified, 

then between L and U. 

 ERFC(L) Complementary error function integrated between L and . 

 FORECAST(...) Predicted Y values for given X. 

 FTEST(R1, R2) The significance level of the two-sided F-test on the 

variances of the data specified by ranges R1 and R2. 

 GMEAN(...) The geometric mean of the arguments. 

 HMEAN(...) The harmonic mean of the arguments. 

 LARGE(R, N) The Nth largest value in range R. 
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 MAX(...) The maximum of the arguments. 

 MEDIAN(...) The median (middle value) of the range R1. 

 MIN(...) The minimum the arguments. 

 MODE(...) The mode or most frequently occurring value. 

 MSQ(...) The mean of the squares of the arguments. 

 PERCENTILE(R, N) The value from the range R that is at the Nth 

percentile in R. 

PERCENTRANK(R, N) The percentile rank of the number N among the  

values in range R. 

 PERMUT(S, T) The number of T objects that can be chosen from the set 

S, where order is significant. 

 PTTEST(R1, R2) The significance level of the two-sided T-test for the 

paired samples contained in ranges R1 and R2. 

 QUARTILE(R, Q) The quartile Q of the data in range R. 

 RANK(E, R[, O]) The rank of a numeric argument E in the range R. 

 SSQ(...) The sum of squares of the arguments. 

 RMS(...) The root of the mean of squares of the arguments. 

 SMALL(R, N) The Nth smallest number in range R. 

 SSE(...) The sum squared error of the arguments. 

 STD(...) The population standard deviation (N weighting) the arguments. 

 STDS(...) The sample standard deviation (N-1 weighting). 

 SUM(...) The sum of the arguments. 

 T(N, T) The integral of Student's T-distribution with N degrees of 

freedom from - to T. 

 TTEST(R, X) The significance level of the two-sided single population  

T-test for the population samples contained in range R. 

 TTEST2EV(R1, R2) The significance level of the two-sided dual 

population T-test for ranges R1 and R2, where the population 

variances are equal. 

14.3  Conditional Statistical Functions 

The following lists supported conditional statistical functions. 

 TTEST2UV(R1, R2) The significance level of the two-sided dual 
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population T-test for ranges R1 and R2, where the population 

variances are not equal. 

 VAR(...) The sample variance (N weighting) of the arguments. 

 VARS(...) The sample variance (N-1 weighting) of the arguments. 

 VSUM(...) The visual sum of the arguments, using precision and 

rounding of formatted cell values. 

 CAVG(..., C) Conditional average. 

 CCOUN(..., C) Conditional count. 

 CMAX(..., C) Conditional maximum. 

 CMIN(..., C) Conditional minimum. 

 CSTD(..., C) Conditional sample standard deviation (N weighting). 

 CSTDS(..., C) Conditional sample standard deviation (N-1 weighting). 

 CSUM(..., C) Conditional sum. 

 CVAR(..., C) Conditional population variance (N weighting). 

 CVARS(..., C) Conditional population variance (N-1 weighting). 

14.4  String Functions 

The following lists supported string functions. 

 CHAR(N) The character represented by the code N. 

 CLEAN(S) The string formed by removing all non-printing characters 

from the string S. 

 CODE(S) The ASCII code for the first character in string S. 

 EXACT(S1, S2) 1 if string S1 matches string S2, otherwise 0. 

 FIND(S1, S2, N) The index of the first occurrence of S1 in S2. 

 HEXTONUM(S) The numeric value for the hexadecimal value S. 

 LEFT(S, N) The string composed of the leftmost N characters of S. 

 LENGTH(S) The number of characters in S. 

 LOWER(S) S converted to lower case. 

 MID(S, N1, N2) The string of length N2 that starts at position N1 in S. 

NUMTOHEX(X) Hexadecimal representation of the integer portion of X. 

 PROPER(S) The string S with the first letter of each word capitalized. 

 REGEX(S1, S2) 1 if string S1 exactly matches string S2; otherwise 0.  

            Allows "wildcard"' comparisons treating S1 as regular expression. 



GSolver V6.1 User guide 

94 

 REPEAT(S, N) The string S repeated N times. 

 REPLACE(S1, N1, N2, S2) The string formed by replacing the N2 

characters starting at position N1 in S1 with string S2. 

 RIGHT(S, N) The string composed of the rightmost N characters of S. 

 STRCAT(...) The concatenation of all the arguments. 

14.5  Logic Functions 

The following lists the supported logic functions. 

STRING(X, N) Numeric value of X as a string to N decimal places. 

 STRLEN(...) The total length of all strings in the arguments. 

 TRIM(S) The string formed by removing spaces from the string S. 

 UPPER(S) The string S converted to upper case. 

 VALUE(S) Numeric value of S as a string; 0 for non-numeric S. 

 FALSE The logical value 0. 

 FILEEXISTS(S) 1 if file S can be opened for reading; otherwise 0. 

 IF(X, T, F) The value of T if X evaluates to 1, or F if X evaluates to 0. 

 ISERROR(X) Returns 1 if X "contains" an error, otherwise 0. 

 ISNUMBER(X) 1 if X is a numeric value; otherwise 0. 

 ISSTRING(X) 1 if X is a string value; otherwise 0. 

 TRUE The logical value 1. 

 AND(...) 0 if any argument is 0; 1 if all arguments are 1; otherwise -1. 

 NAND(...) 0 if all arguments are 1; 1 if any argument is 0; otherwise -1. 

 NOR(...) 0 if any argument is 1; 1 if all arguments are 0; otherwise -1. 

 NOT(X) 0 if X=1; 1 if X=0; otherwise -1. 

 OR(...) 0 if all arguments are 0; 1 if any argument is 1; otherwise, -1. 

 XOR(...) -1 if any argument is not 0 or 1; otherwise 0 if the number of 

arguments valued 1 is even; 1 if the number of arguments  

valued 1 is odd. 

14.6  Date and Time Functions 

The following lists the supported date and time functions. 

 DATE(Y, M, D) The date value for year Y, month M, and day D. 

 DATEVALUE(S) The corresponding date value for a given string S. 
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 DAYS360(S, E) The number of days between two dates, based on a 

30/360 day count system. 

 DAY(DT) The day number in the date/time value DT. 

 EDATE(S, M) The date/time value representing number of months (M) 

before or after start date (S). 

 EOMONTH(S, M) The date/time value of the last day of the month M  

months after S, for M +, or M months before if M is -. 

 HOUR(DT) The hour value (0-23) of date/time value DT. 

 MINUTE(DT) The minute value (0-59) of date/time value DT. 

 MONTH(DT) The number of the month in date/time value DT. 

 NETWORKDAYS(S, E[, H]) Number of working days between S and E. 

 NOW The date/time value of the current system date and time. 

 SECOND(DT) The seconds value (0-59) of the date/time value DT. 

 TIME(H, M, S) The time value for hour H, minute M, and second S. 

 TIMEVALUE(S) The corresponding time value for a given string value S. 

 TODAY The date value of the current system date. 

 WEEKDAY(D) Integer representing the day of the week on which day D 

falls. 1 is Sunday, 7 is Saturday. 

 YEAR(DT) The year value of date/time value DT. 

YEARFRAC(S, E[, B]) The portion of the year represented by the  

number of days between start date S and end date E. 

14.7  Miscellaneous Functions 

The following lists miscellaneous supported functions. 

 CELLREF(N1,N2) A reference to the cell in column N1 and row N2. 

 CHOOSE(N, ...) The Nth argument from the list. 

 COL(C) The column address of the cell referenced by C. 

 COLS(R) The number of columns in the specified range R. 

 HLOOKUP(X, S,R) The cell in range S that is R rows beneath X. 

 INIT(X1, X2) The first argument on the first recalculation pass and the 

second argument on all subsequent recalculation passes when 

Grid is performing iterative calculations. 

 INTERP2D(R1,R2, N) The interpolation value for a 2-dimensional vector. 
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 INTERP3D(R, X,Y)The interpolation value for a 3-dimensional vector. 

 MATCH(V, R[,T]) The relative position in range R of value V based on 

 positioning criteria T. 

 N(R) The numeric value of the top left cell in range R. 

 RANGEREF(N1, N2, N3, N4) A reference to the range defined by 

coordinates N1 through N4. 

 ROW(C) The row address of the cell referenced by C. 

 ROWS(R) The number of rows in the specified range R. 

 S(R) The string value of the top left cell in range R. 

 VLOOKUP(X, S,C) The cell in range S that is C columns right of X. 

 DFT(R) The Discrete Fourier Transform of the range R. 

 EIGEN(M) The eigenvalues of the matrix M. 

FFT(R) The Discrete Fourier Transform of the range R using a fast 

Fourier Transform algorithm. 

 FREQUENCY(R, B) F frequency distribution for R with intervals B. 

 INVDFT(R) The inverse of the Discrete Fourier Transform of the range R. 

 INVERT(M) The inverse of matrix M. 

 INVFFT(R) The inverse of the Discrete Fourier Transform of the range R 

using a fast Fourier Transform algorithm. 

 LINFIT(X, Y) The straight line least squares fit. 
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15  Graphing Options 

The graphing engine uses ProEssentials PEGRP6SG.dll. 

Charts are created from the Results tab, and from the Materials Editor.  

The general chart has several regions that can be customized. Customization 

is accomplished double(or right)-clicking on the graph to invoke the Editor 

Dialog. The several regions are identified in the figure shown below.  

The Tools → 3D Grating View figure provides a representation of the 

current grating structure (used by the RUN or 3D RUN). If the 3D Editor or 

the 3D RUN tab are active when Tools → 3D Grating View is clicked, the 

Legend 

Axis 

Title Canvas 
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3D grating structure is displayed, otherwise the 2D grating structure is 

displayed. 

 

The figure illustrates a 3D grating structure 

 

Right clicking on the display will invoke the graphing Options Dialog. 

Double clicking on the display will start the rotation-view (dynamic 

rotation). Alternatively, the figure orientation may be altered by clicking 

and dragging with the mouse.  
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